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Chapter 732

Superiority by a
Margin Tests for Two
Survival Curves
Using Cox’s
Proportional Hazards
Model
Introduction
A clinical trial may be employed to test the clinical superiority of a treatment over a control in regards to their
survival distributions. Because survival times are not normally distributed and because some survival times are
censored, Cox proportional-hazards regression is often used to analyze the data. The formulation for testing the
significance of a Cox regression coefficient is identical to the standard logrank test. Thus the power and sample
size formulas for one analysis also work for the other.
The Cox Regression model has the added benefit over the exponential model that it does not assume that the
hazard rates are constant, but only that they are proportional. That is, that the hazard ratio remains constant
throughout the experiment, even if the hazard rates vary.
This procedure is documented in Chow, Shao, and Wang (2008) which summarizes the work of Schoenfeld
(1981, 1983). Note that there was an error in Chow, Shao, and Wang (2008) page 179 which caused the sample
size to be doubled. This error has been corrected in this edition.
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Technical Details
Cox’s Proportional Hazards Regression
Cox’s proportional hazards regression is widely used for survival data. The regression model is

h (t | z ) = h (t | 0) exp(bz )
where
b is the regression coefficient which is equal to log[h (t | 1) / h (t | 0) = log(HR )]
z is a binary indicator variable of treatment group
t is elapsed time
h(t|z) is the hazard rate at time t, given covariate z
HR is the hazard ratio h (t | 1) / h (t | 0)

Clinical Superiority Hypothesis
Lower Hazards Better
Assuming that lower hazard rates are better, clinical superiority means that the treatment hazard rate is lower than
the control hazard rate by a clinically significant amount. We find it more convenient to state the hypotheses in
terms of the hazard ratio, HR, rather than the Cox regression coefficient, b. Remembering that b = log(HR) and
assuming that HRsu < 1, clinical superiority requires that HR < HRsu. Here, HRsu is the ratio of clinical
insignificance or the clinical superiority ratio.
The statistical hypotheses that results in the conclusion of clinical superiority when the null hypothesis is rejected
is

H 0 : log(HR ) ≥ log(HRsu ) versus H a : log(HR ) < log(HRsu )
Higher Hazards Better
Assuming that higher hazard rates are better, clinical superiority means that the treatment hazard rate is higher
than the control hazard rate by a clinically significant amount. We find it more convenient to state the hypotheses
in terms of the hazard ratio, HR, rather than the Cox regression coefficient, b. Remembering that b = log(HR) and
assuming that HRsu > 1, clinical superiority requires that HR > HRsu. Here, HRsu is called clinical superiority.
The statistical hypotheses that results in the conclusion of non-inferiority when the null hypothesis is rejected is

H 0 : log(HR ) ≤ log(HRsu ) versus H a : log(HR ) > log(HRsu )

Test Statistic
It can be shown that the test of b based on the partial likelihood method of Cox (1972) coincides with the common
logrank test statistic. When testing non-inferiority, you can use b from a Cox regression or calculate the modified
logrank statistic as follows
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Logrank Test
The logrank test statistic is
K
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Where K is the number of deaths, Yij is the number of subjects at risk just prior to the jth observed event in the ith
group, and Ik is is a binary variable indicating whether the kth even is from group 1 or not.
The distribution of L is approximately normal with mean (log(HR ) − log(HRsu )) P1 P2 dN and unit variance,
where
P1 is the proportion of N that is in the control group
P2 is the proportion of N that is in the treatment group
N is the total sample size
N1 is the sample size from the control group, N1 = N(P1)
N2 is the sample size from the treatment group, N2 = N(P2)
Pev1 is probability of the event of interest in the control group
Pev2 is probability of the event of interest in the treatment group
d is the overall probability of an event, d = Pev1P1 + Pev2P2
b is the Cox regression coefficient, b = log(HR)

Power Calculations
The power of this test is given by

(

Φ (log(HRsu ) − log(HR )) P1 P2 dN − z1−α

)

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power or Sample Size. Select Sample Size when you want to calculate the sample size needed to
achieve a given power and alpha level. Select Power when you want to calculate the power.

732-3
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Superiority by a Margin Tests for Two Survival Curves Using Cox’s Proportional Hazards Model

Test Direction
Alternative Hypothesis
In most studies, a lower hazard rate is better since it indicates a longer life-time. However, in some situations, a
higher hazard rate is desired. For example, if the length of life of disease organisms is being studied. This option
lets you specify which option you have.
Each option results in different null and alternative hypotheses.
•

Ha: HR < HRsu (Lower Hazard Better)
In this case lower is better. The alternative hypothesis is that hazard ratio is lower than a clinically significant
value called the clinical superiority ratio, HRsu.

•

Ha: HR > HRni (Higher Hazard Better)
In this case higher is better. The alternative hypothesis is that hazard ratio is higher than a clinically
significant value called the clinical superiority ratio, HRsu.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
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•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
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Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Sample Size – Proportion of Events Observed
Pev1 (Probability of a Control Event)
Enter one or more values for Pev1, the average probability of an event (death) for each individual in the control
group. The number of events in the control group is equal to Pev1 x N1.
Range
0 < Pev1 < 1
Pev2 (Probability of a Treatment Event)
Enter one or more values for Pev2, the average probability of an event (death) for each individual in the control
group. The number of events in the control group is equal to Pev2 x N2.
Range
0 < Pev2 < 1
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Hazard Ratios
HR (Hazard Ratio = h2/h1)
Specify one or more hazard ratios, HR, at which the power is calculated. HR is defined as the treatment hazard
rate (h2) divided by the control hazard rate (h1). HR represents the assumed value at which the power of rejecting
H0 is calculated. In clinical superiority tests, this ratio must be lower (or higher) than HRsu.
The alternative hypothesis is Ha: HR<HRni or Ha: HR>HRni. The null hypothesis is the complement of Ha.
Range
If Ha: HR < HRsu [Lower Hazard Better] then the range is 0 < HR < HRsu < 1. Typical values are between 0.1 and
HRsu.
If Ha: HR > HRsu [Higher Hazard Better] then the range is HR > HRsu > 1.
Press the “Survival Parameter Conversion Tool” button to estimate reasonable values based on median survival
times, hazard rates, or the proportion surviving.
HRsu (Clinical Superiority Hazard Ratio)
Specify one or more values for the clinical superiority ratio, HRsu. If lower/higher is better, HRsu is the
largest/smallest that HR can be that still concludes clinical superiority.
The one-sided alternative hypotheses are Ha: HR < HRsu or Ha: HR > HRsu.
Range
If Ha: HR < HRsu [Lower Hazard Better], the range is 0 < HR < HRsu < 1.
If Ha: HR > HRsu [Higher Hazard Better], the range is 1 < HRsu < HR.
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Example 1 – Finding the Sample Size
A researcher is planning a clinical superiority trial using a parallel, two-group, equal sample allocation design to
compare the survivability of a new treatment with that of the current treatment. The clinical superiority ratio is
0.75. The desired power is 0.90 and significance level is 0.05. HR will be between 0.2 and 0.5. The probability of
observing an event is 0.50 in the control group and 0.30 in the treatment group.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Two Survival Curves Using Cox’s Proportional
Hazards Model procedure window by expanding Survival, then Two Survival Curves, then clicking
Superiority by a Margin, and then clicking on Superiority by a Margin Tests for Two Survival Curves Using
Cox’s Proportional Hazards Model. You may then make the appropriate entries as listed below or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size
Alternative Hypothesis ......................................... Ha: HR < HRsu [Lower Hazard Better]
Power ................................................................... 0.90
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
Pev1 (Event Probability in Group 1) .................... 0.5
Pev2 (Event Probability in Group 2) .................... 0.3
HR (Actual Hazard Ratio = h2/h1) ....................... 0.2 to 0.5 by 0.1
HRsu (Superiority Hazard Ratio) ......................... 0.75

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: HR < HRsu

Power
0.9050
0.9018
0.9000
0.9005

Total Control Trtmnt
Sample Sample Sample
Size
Size
Size
N
N1
N2
50
25
25
103
51
52
217
108
109
522
261
261

Prop'n
Control
N1/N
P1
0.500
0.500
0.500
0.500

Hazard
Ratio
h2/h1
HR
0.200
0.300
0.400
0.500

Super'ty
Hazard
Ratio
HRsu
0.750
0.750
0.750
0.750

Control
Prob
Event
Pev1
0.500
0.500
0.500
0.500

Trtmnt
Prob
Event
Pev2
0.300
0.300
0.300
0.300

Control Trtmnt
Events Events
E1
E2
13
8
26
16
54
33
131
78

Alpha
0.05
0.05
0.05
0.05

References
Chow, S.C., Shao, J., Wang, H. 2008. Sample Size Calculations in Clinical Research, 2nd Edition. Chapman &
Hall/CRC.
Schoenfeld, David A. 1983. 'Sample Size Formula for the Proportional-Hazards Regression Model', Biometrics,
Volume 39, Pages 499-503.
Report Definitions
Power is the probability of rejecting a false null hypothesis. Power should be close to one.
N is the total sample size.
N1 and N2 are the sample sizes of the control and treatment groups.
P1 is the proportion of the total sample that is in the control group, group 1.
HR is the hazard ratio: h2/h1.
HRsu is the superiority hazard ratio.
Pev1 and Pev2 are the probabilities of an event in the control and the treatment groups.
E1 and E2 are the number of events required in the control and the treatment groups.
Alpha is the probability of a type one error: rejecting a true null hypothesis.
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Summary Statements
A superiority test of whether the hazard ratio with an overall sample size of 50 subjects (of
which 25 are in the control group and 25 are in the treatment group) achieves 91% power at a
0.05 significance level when the hazard ratio is actually 0.200. The superiority ratio is
0.750. The number of events required to achieve this power is 20. It is anticipated that the
proportion of subjects in which the event is observed during the study is 0.500 for the control
group and 0.300 for the treatment group. These results assume that the hazard ratio is constant
throughout the study and that Cox proportional hazards regression or the clinical superiority
logrank test is used to analyze the data.

These reports show the values of each of the parameters, one scenario per row.

Plots Section

This plot shows the relationship between HR and N.
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Example 2 – Validation using Chow et al. (2008)
Chow et al. (2008) page 179 present an example that we will use for validation. In their example, HR = 2,
log(HRsu) = 0.3, Pev1 = Pev2 = 0.8, P1 = 0.5, alpha = 0.05, and power = 0.8. They should have obtained a value
of about 100 per group (this is a correction to Chow et al.’s example in which they obtained 200).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Two Survival Curves Using Cox’s Proportional
Hazards Model procedure window by expanding Survival, then Two Survival Curves, then clicking
Superiority by a Margin, and then clicking on Superiority by a Margin Tests for Two Survival Curves Using
Cox’s Proportional Hazards Model. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size
Alternative Hypothesis ......................................... Ha: HR > HRsu [Higher Hazard Better]
Power ................................................................... 0.80
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
Pev1 (Event Probability in Group 1) .................... 0.8
Pev2 (Event Probability in Group 2) .................... 0.8
HR (Actual Hazard Ratio = h2/h1) ....................... 2
HRsu (Superiority Hazard Ratio) ......................... 1.35 (which is exp(0.3))

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: HR > HRsu

Power
0.8015

Total Control
Sample Sample Sample
Size
Size
Size
N
N1
N2
201
100
101

Trtmnt
Control
N1/N
P1
0.500

Prop'n
Ratio
h2/h1
HR
2.000

Hazard
Hazard
Ratio
HRsu
1.350

Super'ty
Prob
Event
Pev1
0.800

Control
Prob
Event
Pev2
0.800

Trtmnt
Control Trtmnt
Events Events
E1
E2
80.0
80.8

Alpha
0.05

PASS has also calculated the value of N = 201 which is within rounding of the 200 that Chow calculated.
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